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Legal Notices

Warranty. 

Hewlett-Packard makes no warranty of any kind with regard to this manual, including, but not limited to, the 

implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be 

held liable for errors contained herein or direct, indirect, special, incidental or consequential damages in 

connection with the furnishing, performance, or use of this material.

A copy of the specific warranty terms applicable to your Hewlett-Packard product can be obtained from your 

local Sales and Service Office.

Restricted Rights Legend. 

Use, duplication or disclosure by the U.S. Government is subject to restrictions as set forth in subpara-

graph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause in DFARS 252.227-

7013.

Hewlett-Packard Company

United States of America

Rights for non-DOD U.S. Government Departments and Agencies are as set forth in FAR 52.227-

19(c)(1,2).

Copyright Notices.

©Copyright 1999-2005 Hewlett-Packard Development Company, L.P., all rights reserved.

No part of this document may be copied, reproduced, or translated to another language without the 
prior written consent of Hewlett-Packard Company. The information contained in this material is 
subject to change without notice.

Trademark Notices

UNIX® is a registered trademark of The Open Group.

Windows® and MS Windows® are U.S. registered trademarks of Microsoft 
Corporation.

Windows NT® is a U.S. registered trademark of Microsoft Corporation.

Microsoft® is a U.S. registered trademark of Microsoft Corporation.
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IBM® is a U.S. registered trademark of IBM Corporation.

All other product names are the property of their respective trademark or service 
mark holders and are hereby acknowledged.

Support

Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the products, services, and sup-

port that HP OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a 

fast and efficient way to access interactive technical support tools needed to manage your 

business. As a valuable support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit enhancement requests online

Download software patches

Submit and track progress on support cases

Manage a support contract

Look up HP support contacts

Review information about available services

Enter discussions with other software customers 

Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many 

also require a support contract.

To find more information about access levels, go to:
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http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.html
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Web Server SPI Templates and Applications Concepts
Introduction to HP OpenView Operations Smart Plug-in for Web Servers
Introduction to HP OpenView Operations 
Smart Plug-in for Web Servers
The HP OpenView Operations Smart Plug-in for Web Servers (Web 
Server SPI) contains templates and applications specifically designed to 
integrate with HP OpenView Operations.

The Web Server SPI provides powerful, centralized tools to monitor and 
manage the operation of the most widely used Internet servers. Its 
components include:

❏ Templates that are designed to monitor important log files and vital 
processes of Internet servers. See “Templates and Template Groups” 
on page 18 for a detailed list of all available templates. 

❏ Applications that let you query the status of Internet servers and 
start and stop their processes as required. See “Applications and 
Application Groups” on page 17 for a detailed list.

This manual describes the installation, configuration, and usage of the 
Web Server SPI on HP-UX and Sun Solaris management server 
platforms.

NOTE HP OpenView IT/Operations (ITO) and HP OpenView VantagePoint 
Operations (VPO) have been renamed HP OpenView Operations (OVO) 
for UNIX. The name change has not yet been fully implemented across 
the OVO software and documentation. As a result, you may encounter 
references to all three product names.
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Installing the HP OpenView Operations Web Server SPI
Prerequisites and Supported Platforms
Prerequisites and Supported Platforms

The following sections list the hardware and software requirements.

Hardware and Software Requirements

The following section lists the requirements for the HP OpenView Smart 
Plug-in for Web Servers (Web Server SPI) only. HP OpenView Operations 
(OVO) and the operating system should already be installed. 

Table 2-1 OVO Management Server Requirements

Hardware Operating 
System

OVO 
Version Disk Space

HP 9000 Technical 
Workstations

HP-UX 11.0, 
11.11

7.1, 8.0, 
8.1

20 MB

HP-UX 11.23 8.13 20 MB

HP 9000 Enterprise 
Servers

HP-UX 11.0, 
11.11

7.1, 8.0, 
8.1

20 MB

HP-UX 11.23 8.13 20 MB

Sun SPARC Stations Solaris 7, 8, 9 7.1, 8.0, 
8.1

20 MB

Solaris 10 8.13 20 MB

Intel Itanium 
architecture (IA64)

HP-UX 11.23 8.20 20 MB

Table 2-2 OVO Managed Node Requirements

Hardware Operating 
System

OVO 
Version Disk Space

HP 9000 Technical 
Workstations

HP-UX 11.0, 
11.11

7.1, 7.2, 
8.0, 8.1, 
8.20

5 MB
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Installing the HP OpenView Operations Web Server SPI
Prerequisites and Supported Platforms
Software Prerequisites on Management Server

You must make sure that the following components are installed on the 
management server prior to the installation of Web Server SPI:

• HP OpenView Performance SPI Integration Component (DSI2DDF)

• HP OpenView SPI Self-Healing Services (SPI-SHS-OVO)

• SPI Service Discovery Framework (SPI-SVCDISC-OVO)

Refer to the HP OpenView Smart Plug-ins CD Installation Guide for 
additional information about the software prerequisites on the 
management server.

HP 9000 Enterprise 
Servers

HP-UX 11.0, 
11.11

7.1, 7.2, 
8.0, 8.1, 
8.20

5 MB

Sun SPARC Stations Solaris 7, 8, 9 7.1, 7.2, 
8.0, 8.1, 
8.20

5 MB

Intel Architecture 
(Ix86)

Red Hat Linux 
7.0, 7.2, 7.3, 8.0

7.1, 7.2, 
8.0, 8.1, 
8.20

5 MB

Intel Architecture 
(Ix86)

SuSE Linux 7.1, 
7.3, 8.0, 8.1

7.1, 7.2, 
8.0, 8.1, 
8.20

5 MB

Intel Itanium 
architecture (IA64)s

HP-UX 11.23 7.1, 7.2, 
8.0, 8.1, 
8.20

5 MB

Table 2-2 OVO Managed Node Requirements (Continued)

Hardware Operating 
System

OVO 
Version Disk Space
Chapter 2 11



Installing the HP OpenView Operations Web Server SPI
Prerequisites and Supported Platforms
Supported Web Servers

Web Server SPI supports the internet services software listed in 
Table 2-3.

Prerequisite for CODA Data Logging

Make sure that you have the DS12DDF component installed on the 
management server for the CODA data logging components to function 
effectively.

Table 2-3 Supported Web Servers

Platform Internet Services

HP-UX (PA-RISC) Apache Web Server 1.3.26, 2.0.31, 2.0.39, 
2.0.50, 2.0.54

HP Apache 2.0.47, 2.0.48, 2.0.50, 2.0.54

Sun ONE Web Server 6.0, 6.1

Linux (Red Hat) 
Linux (SuSeE)

Apache Web Server 1.3.26, 2.0.39, 2.0.50, 
2.0.54

Sun Solaris Apache Web Server 1.3.26, 2.0.39, 2.0.50, 
2.0.54

Sun ONE Web Server 6.0, 6.1

HPUX (IA-64) Apache Web Server 1.3.26, 2.0.39, 2.0.50, 
2.0.54

HP Apache 2.0.47, 2.0.48, 2.0.50, 2.0.54

RedHat Enterprise 
Linux Advanced 
Server (AS) 3.0 on 
Intel x86

IBM HTTP 6.0 web server.
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Installing the HP OpenView Operations Web Server SPI
Prerequisites and Supported Platforms
Prerequisite for Apache Software Foundation (ASF) 
Apache and HP Apache

The WebServer SPI uses the mod_hpspi module to collect performance 
metrics. To load this module into the Apache web server, you must enable 
the mod_so module before configuring the web server. Refer to the 
Apache Administration Guide for additional information about 
instructions to enable the mod_so module.

Prerequisite for IBM HTTP Server

If you configure the WebServer SPI for IBM HTTP Server using the SPI 
for Web Servers > WebSPI Apache > Configure Apache Node 
application, the following lines are added in the httpd.conf file:

<Location /server-status>

SetHandler server-status

Allow from all

</Location>

These lines load the mod_status module and allows access to the 
/server-status Universal Resource Locator (URL) for the SPI. By 
default, the WebServer SPI provides access to /server-status to all 
hosts. If you want to restrict access to a host, you must mention the host 
name to be restricted as follows:

Replace the line Allow from all in the httpd.conf file with the 
following line:

Allow from <host name> where <host name> is the host from which 
communication must be restricted.

Make sure that the line ExtendedStatus On is present in the 
httpd.conf file. You must make sure that you do not enclose this line 
within any condition statements such as an IfModule condition 
statement.

NOTE Perl 5.8 installation is a prerequisite to configure WebServer SPI for IBM 
HTTP Server. You must verify that the Perl 5.8 executable file is present 
at /usr/bin/perl.
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Installing the HP OpenView Operations Web Server SPI
Prerequisites and Supported Platforms
Prerequisite for non-root agent user support

Perform the following steps at the agent node for non-root agent user 
support:

1.  Switch the agent user to non root using the ovswitchuser 
command.

2. Log in to the agent node as a root user

3. Run wsspi_perl_wrapper.sh wsspi_root.pl from the agent command 
directory for the HTTPS agent, which is as follows:
/var/opt/OV/bin/instrumentation

Refer to the manual, HP OpenView Operations HTTPS Agent Concepts 

and Configuration Guide, for more information about non-root agent 

user.
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Installing the Web Server SPI on the Management Server
Installing the Web Server SPI on the 
Management Server
The sections below explain how to install the Web Server SPI on the 
HP-UX platform and on the Sun Solaris platform.

Installing the Web Server SPI on an HP-UX 
Management Server

1. Login as user root.

2. Set the user root’s umask by entering:

umask 027

3. Create a directory to mount the CD-ROM by entering the following 
commands:

mkdir /<mount_point>

For example:

mkdir /cdrom

4. Insert the HP OpenView Smart Plug-ins for OVO/HP-UX CD-ROM 
into the CD-ROM drive and mount it as user root by entering the 
following command:

mount -r -F cdfs /dev/<cdrom_drive_name> /<mount_point>

For example, on a local CD-ROM, you might enter:

mount -r -F cdfs /dev/dsk/c0t2d0 /cdrom

You can also run SAM and mount the CD-ROM to a specific path in 
the Disks and File Systems window.

5. Install the product by entering the following command:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.sdtape SPI-WS
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Installing the HP OpenView Operations Web Server SPI
Installing the Web Server SPI on the Management Server
Installing the Web Server SPI on a Solaris 
Management Server

1. Insert the HP OpenView Smart Plug-ins for OVO/Solaris CD-ROM 
into the CD-ROM drive. The CD-ROM is automatically mounted 
(and unmounted) on Sun Solaris systems.

2. Install the product by entering the following command:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape SPI-WS
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Installing the HP OpenView Operations Web Server SPI
Web Server SPI Components
Web Server SPI Components
The Web Server SPI installs the following components on the OVO 
management server:

• Message Groups

• Applications and Application Groups

• Templates and Template Groups

Message Groups

Installation of Web Server SPI creates two new message groups, which 
are as follows:

• Web SPI

• Web SPI-Internal

The Message Group Bank is shown in Figure 2-1 below:

Figure 2-1 Web Server SPI Message Groups

Applications and Application Groups

Upon installation the Web Server SPI adds the application group to the 
Application Bank as illustrated in below:
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Installing the HP OpenView Operations Web Server SPI
Web Server SPI Components
Figure 2-2 Web Server SPI Application Groups

The application group called “SPI for Web Servers” contains application 
groups for managing Sun ONE and Apache web servers. For more 
information on applications, see the following sections:

• “Web Server SPI Applications for Managing Apache Web Server” on 
page 31

• “Web Server SPI Applications for Managing Sun ONE Web Server” 
on page 33

NOTE Before many applications can function properly, it is necessary to 
prepare the node for Web Server SPI management by running the 
appropriate Configure Node tool on the managed node.

Templates and Template Groups

The Web Server SPI adds a template group called “SPI for Web Servers,” 
as illustrated in Figure 2-3 on page 19. This template group contains 
additional application groups for monitoring Web Servers. Each template 
group offers templates for log files and for process and performance 
metric monitoring.
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Installing the HP OpenView Operations Web Server SPI
Web Server SPI Components
The additional template group WebSPI_Admin contains a log file 
monitor for the internal error log of the Web Server SPI. For additional 
information on Web Server SPI templates and template groups, see the 
following sections:

• “Web Server SPI Templates for Monitoring Apache Web Server” on 
page 35

• “Web Server SPI Templates for Monitoring Sun ONE Web Server” on 
page 37

Figure 2-3 Web Server SPI Template Groups

NOTE Before deploying Web Server SPI templates to a managed node, first 
prepare the node for management by running the Configure Node tool 
for the appropriate node and installed web server.

Web Server SPI Operator Responsibilities

Web Server SPI operators must be assigned responsibilities to receive 
messages fromWebSPI-Internal and WebSPI message groups, as 
illustrated in Figure 2-4 below.
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Installing the HP OpenView Operations Web Server SPI
Web Server SPI Components
Figure 2-4 Web Server SPI Operator Responsibilities
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Web Server SPI Components
Follow the instructions below to set or edit Web Server SPI Operator 
responsibilities:

1. Open the User Bank as illustrated in 

2. Right-click on a user (to change their responsibilities).

3. Select Modify.

4. Click Responsibilities.

5. Assign responsibilities according to your environment.

For additional information on user responsibilities refer to, HP 
OpenView Operations for UNIX Concepts Guide.
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Uninstalling the Web Server SPI for OVO
Uninstalling the Web Server SPI for OVO
To completely uninstall the Web Server SPI, you must uninstall it first 
from the OVO managed nodes, and then from the OVO management 
server. The uninstallation is semi-automatic, and some manual steps are 
required. Follow these steps to ensure complete removal.

Uninstalling Web Server SPI Components from the 
Managed Nodes 

1. Select the Web Server SPI managed nodes in theWeb Servers Node 
Bank window from which you wish to uninstall the Web Server SPI.

2. Select Actions: Agents -> Assign Templates and remove all Web 
Server SPI templates groups. Click on [OK].

3. Select Actions: Agents -> Install/Update SW & Config from 
the menu. In the Install/Update Web Servers Software and 
Configuration window, check the following checkboxes:

• Templates
• Actions
• Monitors
• Commands

4. Click OK to start the distribution. If the distribution was successful, 
you receive a message in the Web Server’s message browser.

5. Select the managed node and launch the application by 
double-clicking or launching the application:

WebSPI_Admin>Remove WebSPI Instrumentation

The executables and configurations are now removed from the Web 
Server SPI.
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Deleting Web Server SPI Components from the OVO 
Management Server

Web Server SPI components must be deleted manually:

• Delete the Web SPI-Internal and WebSPI-Web Servers message 
groups.

• Delete the SPI for Web Servers application group.

• Delete the SPI for Web Servers template group and all of its groups 
and templates.

To speed the process, use the SHIFT-click method to select multiple 
templates for deletion.

1. To delete the SPI for Web Servers templates and template groups, 
open the Message Source Templates window. 

Open each SPI for Web Servers template group. Then select each of 
the templates in the group. (Use SHIFT-click to select all templates.) 
Select [Delete From All...] to delete the templates.

When you have deleted all templates, select all SPI for Web Servers 
template groups and delete them.

2. To delete the WebSPI-Internal and WebSPI-WebServers message 
groups, open the OVO Application Bank, select the Web Server SPI 
message group, and select Delete from the right-click pop-up menu.

3. To delete the SPI for Web Servers application group and its contents, 
open the OVO Application Bank, select the SPI for Web Servers 
application group, and select Delete from the right-click popup 
menu.

4. To remove Web Server SPI default text, actions, monitors, and 
commands from 
/var/opt/OV/share/databases/OpC/mgd_node/customer/... on 
the management server, run the following commands according to 
the appropriate server platform:

• for Apache servers:

/opt/OV/wsspi/bin/wsspi_apache_clean_acm.sh

• for Sun ONE servers:

/opt/OV/wsspi/bin/wsspi_sunone_clean_acm.sh
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Installing the HP OpenView Operations Web Server SPI
Uninstalling the Web Server SPI for OVO
When you have successfully deleted all Web Server SPI components, 
continue with “Uninstalling the Web Server SPI Components from the 
OVO Management Server.”

Uninstalling the Web Server SPI Components from 
the OVO Management Server

On HP-UX:

1. Uninstall Web Server SPI interactively, using the swremove(1M) 
GUI. To start swremove(1M), enter the following command line:

/usr/sbin/swremove

NOTE The DISPLAY environment variable should be set correctly to your 
system.

2. Select the SPI-WS bundle, mark for removal, and proceed with the 
uninstallation. Or, you can run swremove(1M) from the command 
line by entering the following:

/usr/sbin/swremove SPI-WS

3. Check the following logfiles for problems that may occur during the 
de- installation:

• /var/adm/sw/swagent.log
• /var/adm/sw/swremove.log

On Sun Solaris:

1. Enter the following command line: 

/usr/sbin/swremove SPI-WS

2. Check the following logfiles for problems occurring during the 
uninstallation:

• /var/adm/sw/swagent.log
• /var/adm/sw/swremove.log
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Using Web Server SPI Templates and Applications
Introduction
Introduction
After installation and distribution of Web Server SPI templates and 
instrumentation to a managed node, if any of the web servers are 
running on the node, the SPI discovers the web servers and configures 
them with the SPI. After this configuration, each web server can be 
monitored and managed. 

You can also use the SPI to configure web servers manually by following 
the appropriate instructions in “Manually Configuring Web Servers” on 
page 27.

If you find that you need to adapt any of the default templates supplied 
with Web Server SPI, you can easily do so. See the HP OpenView 
Operations Concepts Guide and the HP OpenView Operations 
Administrator’s Guide to Online Information for general information.

After you have successfully installed, re-installed, or uninstalled the Web 
Server SPI from the managed node, as explained in Chapter 2, Installing 
the HP OpenView Operations Web Server SPI, it is necessary to 
distribute the Web Server SPI templates to the managed nodes.

NOTE You must deploy the default opcmsg(1|3) template for the appropriate 
platform on the node to receive Web Server SPI messages in the message 
browser of the management server.

If you experience error messages from your message browser stating the 
applications are not working properly, ignore the messages until the 
managed nodes have been configured properly. 
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Manually Configuring Web Servers
Manually Configuring Web Servers 
If, for any reason, the Web Server SPI is not able to detect a web server 
instance on a managed node, you can configure it manually. To configure 
web servers manually, follow the relevant procedures below.

Sun ONE Web Server

1. Select SPI for Web Servers > WebSPI SunONE > Configure Sun 
ONE Node.

A message prompts for the magnus.conf path.

2. Enter the complete path to the magnus.conf file.

The web server configuration utility accesses the file. If the file is 
readable and is a valid magnus.conf file, the SPI configures the web 
server.

Apache Web Server

NOTE Before proceeding to configure, make sure that the Apache web server is 
not running.

1. Select SPI for Web Servers > WebSPI Apache > Configure 
Apache Node.

A message prompts for the httpd.conf path.

2. Enter the complete path to the httpd.conf file.

The web server configuration utility accesses the file. If the file is 
readable and is a valid httpd.conf file, the SPI configures the web 
server.
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Web Server SPI Discovery Templates
Web Server SPI Discovery Templates
A Web Server SPI discovery template is a schedule template that detects 
the web servers running on the managed nodes and constructs a service 
map, which is then displayed in the Service Navigator console. There is 
one discovery template for each supported web server: 

• WebSPI-AP-Discovery — This template detects any new instances of 
the Apache web server.

• WebSPI-SO-Discovery — This template detects any new instances of 
the Sun ONE web server.

All discovery templates must be distributed to the management server 
after distributing instrumentation to the managed nodes. Before you 
deploy discovery templates, make sure that the OVO agent has been 
installed on the management server. The discovery template is scheduled 
to run once a day, but you can use the OVO template administration 
window to change this interval. 

Perform the following steps to enable discovery:

1. Assign managed nodes to the WSSPI-Discovery node group.

2. Assign and deploy the service discovery templates on the 
management server. See the template names above and deploy the 
templates that correspond to the types of web servers you use, for 
example, WebSPI-AP-Discovery for Apache web servers.

The discovery template schedules the discovery program to run at 
configured intervals. The program discovers any new instances of the 
web servers running on the nodes.

3. If new web server instances are discovered, the Web Server SPI 
configures them.

The discovery program reads the file 
/var/opt/OV/wsspi/conf/wsspi.cfg and writes the XML file, 
which the system uploads to the Service Navigator database on the 
management server.
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Web Server SPI Discovery Templates
4. View the service map using the Service Navigator console.

Figure 3-1 Sample Discovery Service Map 
Chapter 3 29



Using Web Server SPI Templates and Applications
Web Server SPI Applications for Administration
Web Server SPI Applications for 
Administration
You will find the Web Server SPI applications for administration under 
the Web SPI Admin application group (SPI for Web Servers > 
WebSPI Admin). The applications are described below. 

Application Description Application Input

Remove Web SPI 
Instrumentation

Removes the Web Server SPI 
instrumentation and configuration 
data from a previously configured 
UNIX node. Instrumentation of other 
products is not affected.

None

Show All Web 
Services

Displays the details of all configured 
web services.

None

Show Web SPI 
History Log

Displays the Web Server SPI log file 
for all sites running supported web 
services.

None

Self-Healing Info Gathers system information as well 
as configuration, log, and trace files 
of Web Server SPI when a problem 
occurs in the Web Server SPI.

The information helps you 
troubleshoot the problem. For more 
information, see “Using the 
Self-Healing Info Application” on 
page 43

None
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Web Server SPI Applications for Managing 
Apache Web Server
You will find the Web Server SPI applications for the Apache web server 
under the WebSPI Apache application group (SPI for Web Servers > 
WebSPI Apache). The applications are described below. 

Application Description Application Input

Configure Apache 
Node

Configures Apache with Web Server 
SPI. After configuration is complete, 
SPI will be able to monitor and 
manage web server instances. 
WS-SPI performance Apache module 
(mod_hpspi.c) collects web server 
performance data. To load 
mod_hpspi.c, enable Apache 
mod_so module before configuring 
web server. See Apache 
Administration Guide for 
instructions on enabling mod_so.

path to httpd.conf

UnConfigure 
Apache Node

Removes the configuration 
information of the specified Apache 
node.

IP address and port number

Start Apache Starts Apache web server. IP address and port number

Stop Apache Stops Apache web server. IP address and port number

Restart Apache Restarts Apache web server. IP address and port number

Status of Apache Displays Apache web server status. IP address and port number

Show Apache 
Configuration

Displays Apache configuration 
details.

IP address and port number

Show Apache Node 
Details

Displays Apache web server details, 
such as server root, document root, 
and web server version.

IP address and port number
Chapter 3 31



Using Web Server SPI Templates and Applications
Web Server SPI Applications for Managing Apache Web Server
NOTE You will be prompted to enter an IP address as application input only if 
the web server is configured to run on multiple IP addresses. 

Show Apache 
Error Log

Displays Apache web server error log 
file.

IP address and port number

Show Apache 
Access Log

Displays Apache web server access 
log file.

IP address and port number

Configure CODA Compiles the CODA configuration 
specification files and creates the log 
file set.

None

Application Description Application Input
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Web Server SPI Applications for Managing 
Sun ONE Web Server
You will find the Web Server SPI applications for the Sun ONE web 
server under the WebSPI Sun ONE application group (SPI for Web 
Servers > WebSPI Sun ONE). The applications are described below. 

Application Description Application Input

Configure Sun 
ONE Node

Configures Sun ONE with Web 
Server SPI. After configuration is 
complete, SPI will be able to monitor 
and manage web server instances. 
WS-SPI collects performance data 
from web server SNMP agent; 
configure SNMP agent with Sun 
ONE web server before configuring 
web server with SPI.

path to magnus.conf

UnConfigure Sun 
ONE Node

Removes the configuration 
information of the specified Sun 
ONE node.

IP address and port number

Start Sun ONE Starts Sun ONE web server. IP address and port number

Stop Sun ONE Stops Sun ONE web server. IP address and port number

Restart Sun ONE Restarts Sun ONE web server. IP address and port number

Status of Sun ONE Displays Sun ONE web server 
status.

IP address and port number

Show Sun ONE 
Configuration

Displays Sun ONE configuration 
details.

IP address and port number

Show Sun ONE 
Node Details

Displays Sun ONE web server 
details, such as server root, 
document root, and web server 
version.

IP address and port number

Show Sun ONE 
Error Log

Displays Sun ONE web server error 
log file.

IP address and port number
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NOTE You will be prompted to enter an IP address as application input only if 
the web server is configured to run on multiple IP addresses. 

Show Sun ONE 
Access Log

Displays Sun ONE web server access 
log file.

IP address and port number

Application Description Application Input
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Web Server SPI Templates for Monitoring 
Apache Web Server
You will find the Web Server SPI templates for monitoring the Apache 
web server by following this navigation path: Window > Message Source 
Templates > SPI for Web Servers > WebSPI Apache. The following 
table describes the templates. 

Template Description

WebSPI-AP-LogMon Monitors the Apache web server’s error log file. The 
template sends messages to the OV message browser for 
the following conditions in the web server error log file: 
Alert, Critical, Error, or Warning.

WebSPI-AP-BusyProcessRate Computes the percentage of processes that are running 
serving requests versus the total number of web server 
processes.

WebSPI-AP-BytesPerReq Computes the number of bytes that each request contains.

WebSPI-AP-BytesPerSec Computes the Apache web server number of inbound 
bytes transferred per second.

WebSPI-AP-CODALOG Collects data for each configured Apache web server and 
logs it into CODA. The metrics collected for each web 
server instance include the IP address, port number, CPU 
usage, memory usage, number of bytes transferred every 
second, number of bytes transferred for every request, and 
percentage of busy processes for the web server instance. 
By default, the template runs every five minutes.

WebSPI-AP-CPUUsage Computes the percentage of CPU used by the Apache web 
server.

WebSPI-AP-Discovery Detects any new instances of the Apache web server.

WebSPI-AP-MEMUsage Computes the percentage of total system memory used by 
the Apache web server.

WebSPI-AP-NumRequests Computes the number of requests processed by the 
Apache web server.
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WebSPI-AP-ProcMon Checks whether the Apache web server processes of the 
configured instance are running.

WebSPI-AP-ResponseTime Computes the Apache web server response time.

Template Description
Chapter 336



Using Web Server SPI Templates and Applications
Web Server SPI Templates for Monitoring Sun ONE Web Server
Web Server SPI Templates for Monitoring Sun 
ONE Web Server
You will find the Web Server SPI templates for monitoring the Sun ONE 
web server by following this navigation path: Window > Message Source 
Templates > SPI for Web Servers > WebSPI Sun ONE. The following 
table describes the templates. 

Template Description

WebSPI-SO-LogMon Monitors the Sun ONE web server’s error log file. The 
template sends messages to the OV message browser if 
any of these conditions occurs for the monitored web 
server instance: Alert, Critical, Emergency, Error, or 
Warning.

These message types are suppressed: Notice and Info.

WebSPI-SO-CPUUsage Computes the percentage of CPU used by the Sun ONE 
web server. A Critical message is sent to the OV message 
browser if CPU usage goes above 80%.

WebSPI-SO-Discovery Detects any new instances of the Sun ONE web server.

WebSPI-SO-ErrorRate Computes the number of errors generated as compared to 
the total number of requests.

WebSPI-SO-MemoryUsage Computes the percentage of total system memory used by 
the Sun ONE web server. A Critical message is sent to the 
OV message browser if the memory usage goes above 70%.

WebSPI-SO-ProcMon Checks whether the Sun ONE web server processes of the 
configured instance are running.

WebSPI-SO-ResponseTime Computes the Sun ONE web server response time.

WebSPI-SO-ThreadRate Computes the percentage of Sun ONE web server running 
threads compared to the total number of threads.
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Web Server SPI Template for Monitoring SPI 
Log Files
You will find the Web Server SPI template for monitoring the Web Server 
SPI log files following this navigation path: Window > Message Source 
Templates > SPI for Web Servers > WebSPI Admin. 

The template, which is called WebSPI-InternalErrorLog, monitors the 
Web Server SPI error log file. The template sends a message to the OV 
message browser if any of these message types appears in the error log 
file: Error, Info, or Warning.
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Web Server SPI Software Bundle
The Web Server SPI principal bundle is a hierarchical structure made up 
of associated bundles, products, and filesets. You can view these software 
components using the swinstall GUI of SD-UX if you are running web 
servers on an HP-UX management server.

Table A-1 Web Server SPI Software Bundle and Filesets

Name Description

Web Server 
SPI Product

SPI-WS HP OpenView Smart Plug-in for Web Servers

Web Server 
SPI Filesets 
(contained in 
SPI-WS 
Bundle)

WSSPI-CORE WSSPI—Common Core/Documentation for OVO

WSSPI-HPUX WSSPI for HPUX

WSSPI-LINX WSSPI for Linux

WSSPI-SOL WSSPI for Solaris

WSSPI-AP-CORE WSSPI for Apache Server Common Core

WSSPI-AP-HPUX WSSPI for Apache Server on HP-UX

WSSPI-AP-LINX WSSPI for Apache Server on Linux

WSSPI-AP-SOL WSSPI for Apache Server on Solaris

WSSPI-SO-CORE WSSPI for Sun ONE Server Common Core

WSSPI-SO-HPUX WSSPI for Sun ONE Server on HP-UX

WSSPI-SO-LINX WSSPI for Sun ONE Server on Solaris

WSSPI-SO-SOL WSSPI for Sun ONE Server on Linux
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Assistance with Problems
This chapter provides problem descriptions and troubleshooting steps for 
the Web Server SPI only. For general troubleshooting, please refer to the 
HP OpenView Operations for UNIX Administrator Reference Volumes I 
and II.
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Applications and Monitors Report Missing 
Configuration

All applications except the Configure Node applications rely on a 
properly configured node. If you receive an error message like the 
following when starting an application your node has not yet been 
configured:

Configuration file /var/opt/OV/wsspi/conf/wsspi.cfg not 
found or no read access.

This error probably occurred because you did not configure the node for 
management of the Apache web server. You must run the Apache 
configuration tool on this node before you are able to launch this tool.

You will also get error messages in the Message Browser if you have 
deployed the process monitor templates on any nodes that have not been 
configured. In both cases, run the proper Configure Node application 
according to your web server until this application succeeds.

Using the Self-Healing Info Application

The Self-Healing Info application gathers system information as well as 
configuration, log, and trace files of Web Server SPI when a problem 
occurs in the Web Server SPI.

All the gathered information and files are placed in a pre-defined output 
directory, thereby facilitating faster troubleshooting. Also, the data 
collector is used to gather real-time data, which reduces the probability 
of troubleshooting with stale data.

To greatly enhance troubleshooting, and access the search and 
cross-referencing capabilities of the HP Support web site, you can 
download and use the Self-Healing Services client software. Refer to 
the relevant section in the HP OpenView Operations for UNIX SPI CD 
Installation Guide for more information on how to download and use the 
software, and to set up the automatic link to the HP support web site.

If Self-Healing Services client is not installed and configured on the node 
being managed by the SPI, you can use the Self-Healing Info application 
to collect system information.

Whenever you encounter a problem with the Web Server SPI, run the 
data collector by launching the Self-Healing Info application in the 
WebSPI Application group.
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NOTE Prior to using the Self-Healing Info application, turn on tracing, 
reproduce the problem, and then run the application.

To launch the data collector on the node from where you want to gather 
data, drag the icon of the node and drop it on the Self-Healing Info 
application in the WebSPI Application group window for the respective 
operating system. The output is placed as 
/tmp/SPI_WEBSERV_support.tar on UNIX nodes. You can submit this 
file to HP Support for assistance or use this file to identify and correct 
the problem you encountered.

NOTE Depending on the Windows setting, the file may be a hidden file on some 
managed nodes. If you do not see the file, open Windows Explorer and 
from the Tools menu select the View tabbed page in the Folder 
Options.. . Under Hidden Files and Folders, select Show Files and 
Folders.

Web Server SPI Log Files

The web server SPI provides two different log files, which are located in 
the directory /var/opt/OV/wsspi/log on the managed nodes.

Error Log

Error, warning, and information messages from actions, commands, and 
monitors are logged to the Web Server SPI’s error log file 
/var/opt/OV/wsspi/log/wsspi_error.log. 

If you deploy the template WebSPI_InternalErrorLog on the managed 
node, all new entries will be forwarded to the management server and 
displayed in the default text below:

Message Browser (Application: WebSPI; Message Group: 
WebSPI-Internal; Object: error_log).
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Trace Log

If you enable tracing, the tracing information will be logged to 
/var/opt/OV/wsspi/log/wsspi_trace.log. 

NOTE The trace log is not localized.

Using Tracing

Tracing enables you to drill down to the source of problems by getting 
more information on what the scripts are processing.

How to Enable Tracing

1. Log in to the managed node.

2. Locate and change the script you wish to trace:

• For HTTPS: /var/opt/OV/bin/instrumentation 

• For DCE, the directory is branched into three sub-directories
Actions: /var/opt/OV/bin/OpC/actions
Commands: /var/opt/OV/bin/OpC/cmds
Monitors: /var/opt/OV/bin/OpC/monitor

3. Open the script you wish to trace with a text editor.

4. Find the line below and uncomment it: 
#WSSPI_TRC_LVL=<trace_level>

5. Set trace level to a number between 0 and 9, where a trace level of 0 
sets tracing off and a trace level of 9 gives you the all available 
tracing messages

The format of each trace message is as follows:

<date> <time> WSSPI(<trace_obj>-<pid>): <message>

Where the fields have the following meanings: 

<date> Current date, when the message has been added.

<time> Current time, when the message has been added
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Sample Trace Files

A sample output of a trace file for the configuration of an Apache server 
with trace level 9 is listed below:

11/28/2001 10:22:22 WSSPI(wsspi_ap_conf.sh-28925): 
Configuration started: Command: wsspi_ap_conf.sh

11/28/2001 10:22:22 WSSPI(wsspi_ap_conf.sh-28925): Running 
discovery in non-interactive mode.

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getApacheBinUsingRpm(): No Apache RPM package found.

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getApacheBinUsingPathes(): Searching for Apache binary in 
the path /bin/httpd

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getApacheBinUsingPathes(): Searching for Apache binary in 
the path /sbin/httpd

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getApacheBinUsingPathes(): Searching for Apache binary in 
the path /usr/sbin/httpd

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getApacheBinUsingPathes(): Found Apache binary: 
/usr/sbin/httpd

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getApacheBin(): No Apache binary in predefined paths found.

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getHttpConfUsingProcess(): System is a non-HP-UX system

<trace_obj> Trace object, in general the name of the script that is 
the source of the trace message.

<pid> Process ID of the script.

<message> The message text. If the message is sent from a sub 
function, this message contains the name of the 
function as prefix.
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11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getHttpConfUsingProcess(): Found configuration file in 
parameters: /etc/httpd/httpd.conf

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getServerRoot(): Found server root in Apache configuration 
file:

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getHttpdPid(): Found pid file: /var/run/httpd.pid

11/28/2001 10:22:32 WSSPI(wsspi_ap_conf.sh-28925): 
getHttpLog(): Found error log file: /var/log/httpd/error_log

11/28/2001 10:22:33 WSSPI(wsspi_ap_conf.sh-28925): 
createLinks(): Created links to the error log files in the 
directory /var/opt/OV/wsspi/link/apache.

11/28/2001 10:22:33 WSSPI(wsspi_ap_conf.sh-28925): 
writeConf(): Discovered information about managed server 
written to /var/opt/OV/wsspi/conf/wsspi_apache.cfg.

11/28/2001 10:30:02 WSSPI(wsspi_ap_conf.sh-29659): 
Configuration started: Command: wsspi_ap_conf.sh

11/28/2001 10:30:03 WSSPI(wsspi_ap_conf.sh-29659): Running 
discovery in non-interactive mode.

11/28/2001 10:30:11 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBinUsingRpm(): No Apache RPM package found.

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBinUsingPathes(): Searching for Apache binary in 
the path /bin/httpd

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBinUsingPathes(): Searching for Apache binary in 
the path /sbin/httpd

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBinUsingPathes(): Searching for Apache binary in 
the path /usr/sbin/httpd

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBinUsingPathes(): Found Apache binary: 
/usr/sbin/httpd

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBin(): No Apache binary in predefined paths found.
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11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getHttpConfUsingProcess(): System is a non-HP-UX system

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getHttpConfUsingProcess(): Found configuration file in 
parameters: /etc/httpd/httpd.conf

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getServerRoot(): Found server root in Apache configuration 
file:

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getHttpdPid(): Found pid file: /var/run/httpd.pid

11/28/2001 10:30:12 WSSPI(wsspi_ap_conf.sh-29659): 
getHttpLog(): Found error log file: /var/log/httpd/error_log

11/28/2001 10:30:13 WSSPI(wsspi_ap_conf.sh-29659): 
getApacheBinParameters() determined that Apache has been 
started with the following parameters: -f 
/etc/httpd/httpd.conf

11/28/2001 10:30:13 WSSPI(wsspi_ap_conf.sh-29659): 
createLinks(): Created links to the error log files in the 
directory /var/opt/OV/wsspi/link/apache.

11/28/2001 10:30:13 WSSPI(wsspi_ap_conf.sh-29659): 
writeConf(): Discovered information about managed server 
written to /var/opt/OV/wsspi/conf/wsspi_apache.cfg.

Node Configuration Problems

This section provides assistance with problems that may arise when you 
configure nodes.

1. ERROR :cp: Cannot create <apache home 
directory>/modules/mod_hpspi.so: Text file busy.

Solution: Stop the Apache web server and run the "Configure Apache 
Node" application again.

Discovery Problems

This section provides assistance with problems that may arise when you 
use the Web Server SPI discovery program.
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1. System is unable to detect the web servers.

Solution: Web server instances may not be running on the managed 
node. If no web server instances are running, the discovery program 
cannot detect them.

For more information on the exact cause of the problem, check the 
WS-SPI internal error log file: /var/opt/OV/wsspi/log/wsspi_error.log.

2. System is unable to create the Web Server SPI service map.

Solution: Make sure that managed nodes are assigned to the 
WSSPI-Discovery node group and verify that the appropriate discovery 
templates are deployed to the management server.

3. System is unable to run the discovery program on a managed 
node.

Solution: Make sure that the node is assigned to the WSSPI-Discovery 
node group and that the OVO agent is running on the managed node. 

Also, be aware that the discovery program uses the opctranm tool to 
perform the discovery process. If multiple instances of opctranm are 
running simultaneously, make sure that the appropriate patch is 
installed on the management server: 

• For HP-UX, patch PHSS_30125

• For Sun Solaris, patch ITOSOL_00266

Without this patch, the discovery program exits if it encounters multiple, 
simultaneous instances of opctranm.
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